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Integrated FPGA Design & Simulation

Active-HDL is both a HDL Design tool & a Mixed
Language Simulator in one integrated Multi-FPGA
(AMD®, Altera®, Lattice®, Microchip®) 
and design entry and simulation environment

Included Technology
› Team-based Project Management
› HDL Design Tool Suite
› Mixed Language RTL Simulator
› VHDL, Verilog, SystemVerilog,

SystemC
› Coverage Tools Bundle (Option)
› Assertions & Functional Coverage (Option)
› DSP Co-Simulation MATLAB & Simulink
› PCB Interface
› Documentation Generator
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Aldec Active-HDL in a nutshell
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› Common-Kernel Mixed Language Simulator
› Languages:  VHDL, Verilog, SystemVerilog, SystemC

& EDIF
› HDL Design Tools: Design entry, Design Creation, 

Code2Graphics , Block and State Diagram, 
Waveform editor, stimulus generation, Language 
templates & auto-complete, scripting.

› Design Flow Manager:  use popular third-party tools 
throughout the design flow within the same FPGA 
environment.

› Debugging: Code execution tracing, 
Waveform/Compare, Memory Viewer, Xtrace, 
Advanced Dataflow and Profiler. 

› Coverage: Code Coverage, Toggle & Functional 
Coverage.

› Additional Interfaces:  DSP/HDL algorithm MATLAB® 
and Simulink® Interfaces & Zuken CADSTAR PCB 
Design

› Project Documentation Entire workspace or single 
file export to  PDF/HTML.

› Assertion and Coverage SystemVerilog and PSL 
support.  Dedicated Assertion viewer, coverage, 
breakpoint editor.
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FPGA Vendor Independent IDE for RTL-User 
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Design Flow Manager
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› Design Flow Manager interfaces to 200+ different 3rd party tools

› Manages the HDL, C and Physical Synthesis Tools

› Runs the implementation for any FPGA vendor

› Generates TCL scripts 
for advanced automation

› Runs the simulation at all stages of design

› Invokes external analysis tools provided by silicon vendors
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User-defined Design Management

› Separate HDL files from 
other types of files, e.g. 
schematics, text, waveform 
and scripts

› Easily maintain and adhere 
to design structure required 
by entire team or a company

› Create directory structure 
that is compatible to other 
synthesis and 
implementation tool 
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Team-based Design
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Advanced HDL Editor

› Code analysis and navigation tools
› Action Recorder for often repeated

operations
› Keyword and Signal name 

auto-completion
› Automatic structure generation 

for enhanced legibility
› Built-in customizable language

assistant
› Source code auto-formatting
› Advanced Find, Find in Files 

and replace, Column Selection
› Navigation Bookmarks
› Ability to interface to third 

party text editors
› OpenAI helper included
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Block Diagram Editor

› Multi-page hierarchical 
block diagrams

› Multidimensional arrays 
and record signals 
supported

› Bottom-up and top-down 
design methodologies 
supported

› Allows mixed structural 
and behavioral elements

› Cross probing with 
generated code

› Handles mixed HDL designs
› Customizable design rules checking 
› Imports schematics
› Customizable symbols
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Finite State Machine Editor

› Multiple State Machines on a 
single diagram

› Full-Moore machines support
› Hierarchical states and junctions 

provided for legibility
› Delay states simplify control of 

machine timing
› Advanced code generation settings
› Automatic testbench generation 
› Graphical FSM debug
› FSM Coverage included

Active-HDL 15 Overview Presentation



10 www.aldec.com

Project Documentation

› Entire workspace, individual designs or files can 
be printed or exported to vector PDF

› The HTML document closely resembles Active-
HDL environment layout

› Vector graphics and other
advanced PDF options available

› Graphical Design Entry documents can be 
accompanied  by generated code

› Ideal solution for design
documentation 
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Code2Graphics

› Converts HDL code into graphical representation:
› Block Diagrams
› Finite Stae Machines
› Editor files

› Creates perfect documentation for HDL 
designs

› Helps with debugging of large designs
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Common Kernel Simulator

› VHDL, Verilog, EDIF, SystemC and SystemVerilog
› Ultra Fast Verilog Simulation
› Strict IEEE Standards Adherence:

› VHDL: IEEE 1076-1993 Standard, IEEE 1076 -2002 VHDL 
Standard, IEEE 1076 -2008 Standard and IEEE 1076 -2019 
Standard. 

› Verilog: IEEE 1364-1995 Standard, IEEE 1364-2001 Standard, 
IEEE 1364-2005 Standard IEEE 1364-2005 Standard. 

› SystemVerilog: IEEE Std. 1800 -2012
› PSL embedded in VHDL
› VHPI interfacing to C/C++ code
› Verilog PLI (Programming Language Interface) and VPI (Verilog 

Procedural Interface) are supported as described in the IEEE 
1364 Standard

› Performance Optimizations (Verilog and VHDL)
› Extensive debugging while strictly adhering to IEEE Standards.
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FPGA Requirements Test Scenarios

Code Name File Code Name File

FPGA-001 Name of fpga-001 fpga_requirements.txt TST-001 Name of test1 test scenarios.txt

FPGA-002 Name of fpga-002 fpga_requirements.txt TST-003 Name of test3  test scenarios.txt

FPGA-003 Name of fpga-003 fpga_requirements.txt

Spec-TRACER

Traceability Capture and Reporting
› Document Types:

› Microsoft® Word
› Microsoft® Excel
› Text/design files

› Capture methods:
› Regular expression
› Document style
› Spreadsheet/table column

› Traceability Matrices Report
› Upstream and Downstream coverage analysis
› Traceability links consistency verification
› Microsoft® Excel and CSV

System
Requirements

FPGA
Requirements 

HDL
Design

Conceptual
Design

Simulation 
Results

Test
Scenarios

Testbench
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HDL Source Encryption / IP Protection

› Support for the latest industry standards:
› IEEE 1735 Version 1 Recommendations
› IEEE 1735-2014 Version 2 using delegated rights
› Encryption methods defined in Verilog 
IEEE Std 1364-2005 and VHDL IEEE 1076-2008 Standards

› Simulating encrypted files requires no action at Active-HDL user’s 
side (given IP vendor encrypted the files for target simulation tool)

› Decrypts the source on-the-fly, leaving no traces that could 
compromise the security of encryption

› Supports DES, 3DES, AES and Blowfish encryption algorithms
› Up to 256 bit encryption keys (AES)
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Waveform Viewing and Editing
› Waveform Viewer for fast handling 

of large simulation databases
› Instant zooming and scrolling
› Multiple cursors and bookmarks
› Waveform comparison
› Sort signals and browse by 

differences in two waveform files.
› Export to VCD (Verilog and VHDL)
› Embedded List Window displays the 

object values in an ASCII format
› User-friendly Waveform Editor for 

manipulating signal data
› Hand-drawing stimulus for 

interactive simulation
› Preparation of data for automatic 

testbench generation
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› Strobe Comparison command to compare signals probed by different strobe signals
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Debug

Design Synthesis Place & 
Route
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Functional Simulation Post-synth Simulation Timing Simulation

Standard Debugging Tools:
✔Waveform Viewer
✔Interactive Code Execution Tracing
✔Breakpoint Management
✔Code Browser

Advanced Debugging Tools:
✔XTrace
✔Advance Dataflow
✔Code Coverage
✔Static Rule Checking

Each FPGA vendor 
offers something 
but all different

Aldec provides all tools 
which are vendor 
independent and 
available as perpetual 
license
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Debugging Tools

› View simulation results in
› Waveform Viewer
› List Viewer
› Memory View
› Watch
› Advanced Dataflow

› Trace code execution with
› Processes

› Call Stack
› Graphical Debug

› FSM
› BDE
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Stimulus

› Graphical Stimulus Creation
Convenient GUI window (Stimuli Window) for creation of force stimulus for use in 
the waveform viewer. 

› Force command
The syntax of force command provides two kinds of stimuli based on file contents -
custom and text.

› When a text file stimulus is used, the force command reads the values of signals to be 
forced from a plain text file. 

› The custom stimulus can read test vectors from a number of file types:
› Aldec Simulation Database (.ASDB)
› Custom text stimulus (.TXT)
› Value Change Dump (.VCD)
› MATLAB Binary Data Files (.MAT)

› Force Capabilities Inside HDL Code
The functionality of the force command is available not only in macros but
also directly in VHDL or Verilog code (VHDL procedure force and Verilog task $force).
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Advanced Dataflow and XTrace

› Allows exploration of design in graphical 
representation

› Shows the drivers-readers connection
and simulation values

› The XWay feature finds the source
of unknown value

› Gray mode provided for better legibility
› The XTrace feature allows detection of 

irregular values  when they happen
› Combined with advanced

dataflow creates powerful debugging 
tool
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Coverage

› Code coverage checks how many
times each statement is executed

› Branch/expression/condition coverage 
provide detailed statistics 
on execution of conditional statements 
and assignments

› Path Coverage collects information
about the program execution and 
program sequences (program paths)

› Toggle coverage reports design activity
in terms of changes in signal values

› FSM coverage allows to identify not 
visited states, transitions and sequences 
of states

› Functional coverage allows to collect 
coverage data from OSVVM code and 
SystemVerilog (Verification)
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Verification Plan
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Verification flow with a user-defined test plan

› Enables validating the verification 
process with a test plan

› It allows users to link the requirements
from test plan to coverage results to see 
if verification goals have been reached or 
not

› Allows user to rank tests to select 
minimal testsuit for regression tests
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Extensive list of Verification Libraries Support

Active-HDL compiles and simulates HDL verification 
constructs. This provides the ability to simulate using 
advanced verification methods like functional coverage and 
constrained randomization.
Active-HDL supports followings verification libraries:
› UVM 1.1d, 1.2, 1800.2-2017, 1800.2-2020
› OSVVM
› UVVM
› VUnit
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Profiler

› Profiler measures information on statement execution time 
and helps to identify performance bottlenecks

Active-HDL 15 Overview Presentation



www.aldec.com24

Automatic Testbench Generation

› Automatic generation of 
simulation testbench in different 
styles:
› Generate testbench template for any 

design unit.
› Generate complete testbench from test 

vector inputs such as waveform file.
› Generate complete testbench that 

compares simulation result against 
golden test vectors.

› Automatic Testbench Generation 
for Finite State Machines (FSM) in 
three different styles
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MATLAB and Simulink Co-Simulation

› Direct Co-Simulation Interface to: 
› MATLAB 
› Simulink

› Call MATLAB functions directly from HDL code or
call Active-HDL from MATLAB

› High speed system-level testbench 
and co-verification environment
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Simple and fast setup of all 
Simulink co-simulation parameters
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Unit Linting

› Build-in interface to ALINT-PRO allows to
lint selected units and present results within 
Active-HDL User Interface

› Pre-linting allows to get rid of most issues 
before full linting and synthesis process 

Active-HDL 15 Overview Presentation



www.aldec.com27

ALINT-PRO Interface
› Detects wide variety of design 

problems at design entry
› Be aware of hidden bugs
(from synthesizability to CDC                                                                                                
and DFT issues)

› Prevent issues at subsequent                                                                                  
stages of the flow                                                                                                
(avoid costly re-spins)

› Get started quickly using                                                           
predefined design checking                                     
policies

› Pick a dedicated rule plug-in
(STARC, DO-254, RMM, CDC and more)

› Available as an option for DM and PE configurations 
› Included in EE configuration
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Assertion Based Verification  SVA and  PSL

› PSL and SystemVerilog
› Properties/assertions/covers embedded in HDL code or kept in separate files
› Assertion and cover messages in simulator console
› View assertions and covers in a dedicated Assertion Viewer 

(status and statistics for each assertion/cover)
› Set Assertion Breakpoints and edit them in the new Assertion tab of Breakpoint Editor
› Assertions and Covers tabs in Code Coverage Viewer :  

view statistics for the entire monitored design
› Assertions displayed in Structure tab of the Design Browser 
› HDL Editor and Language Assistant: syntax highlighting, code auto-complete, and pre-

defined language templates. 

Active-HDL 15 Overview Presentation



www.aldec.com29

Conclusion

› Common Kernel Simulator supporting mixed VHDL, Verilog, EDIF, 
SystemC and SystemVerilog simulation

› Integrated Design Entry and Verification Environment
› Interfaces to FPGA and Logic Synthesis product from universal Design 

Flow manager – vendor independent
› Ability to invoke simulations in batch mode or GUI, compete user control
› Advanced Debugging and Analysis Tools
› Support  for Encrypted IP delivery from FPGA Vendors and IP Providers
› Powerful interface to Matlab/Simulink for signal processing applications 

– co-simulation
› Assertions Support Available – SVA, PSL
› Advanced verification: UVM, OSVVM, UVVM, Cocotb.
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Solutions
Riviera-PRO
Advanced Verification Platform

Active-HDL
FPGA Design and Simulation

ALINT-PRO
Design Rule Checking

HES-DVM
HW/SW Validation Platform

TySOM
High Performance Embedded Development 
Spec-TRACER
Requirements Lifecycle Management

DO-254/CTS
FPGA Level In-Target Testing

HES
SoC/ASIC Prototyping 

RTAX/RTSX
Prototyping Microchip Rad-Tolerant Devices

Corp. Headquarters 
2260 Corporate Circle , Suite 400
Henderson, NV 89074

Ph +1.702.990.4400  
Fax +1.702.990.4414
sales@aldec.com

Training https://www.aldec.com/training

Support https://www.aldec.com/support

Blog         https://www.aldec.com/company/blog
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